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PREFACE

As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.

Contact your EMC representative if a product does not function properly or does not 
function as described in this document.

Note: This document was accurate at publication time. New versions of this document 
might be released on the EMC Online Support website. Check the EMC Online Support 
website to ensure that you are using the latest version of this document.

Audience
This manual is part of the PowerPath documentation set. It is intended for use by storage 
administrators and other information system professionals responsible for installing, 
using, and maintaining PowerPath software.

Readers of this manual are expected to be familiar with the host operating system, storage 
system management, and the applications used with PowerPath software.

Related documentation
The complete set of EMC enterprise storage documentation for PowerPath, available from 
EMC Corporation, is available on EMC Online Support. These documents are updated 
periodically.

Revision history
The following table presents the revision history of this document.

Conventions used in this document
EMC uses the following conventions for special notices:

CAUTION, used with the safety alert symbol, indicates a hazardous situation which, if not 
avoided, could result in minor or moderate injury. 

NOTICE is used to address practices not related to personal injury.

Revision Date Description

03 May 2016 Release of PowerPath for Windows 6.0 SP2. Removed 
Windows Server 2003 references.

02 February 2016 Release of PowerPath for Windows 6.0 SP1

01 December 12, 2014 First release of the EMC PowerPath for Windows Version 6.0
EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide 9



Preface
Note: A note presents information that is important, but not hazard-related.

IMPORTANT

An important notice contains information essential to software or hardware operation.

Typographical conventions

EMC uses the following type style conventions in this document:

Where to get help
EMC support, product, and licensing information can be obtained as follows:

Product information — For documentation, release notes, software updates, or 
information about EMC products, licensing, and service, go to the EMC Online Support 
website (registration required) at:

https://support.emc.com

Normal Used in running (nonprocedural) text for:
• Names of interface elements, such as names of windows, dialog boxes, 

buttons, fields, and menus
• Names of resources, attributes, pools, Boolean expressions, buttons, 

DQL statements, keywords, clauses, environment variables, functions, 
and utilities

• URLs, pathnames, filenames, directory names, computer names, links, 
groups, service keys, file systems, and notifications

Bold Used in running (nonprocedural) text for names of commands, daemons, 
options, programs, processes, services, applications, utilities, kernels, 
notifications, system calls, and man pages

Used in procedures for:
• Names of interface elements, such as names of windows, dialog boxes, 

buttons, fields, and menus
• What the user specifically selects, clicks, presses, or types

Italic Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis, for example, a new term
• Variables

Courier Used for:
• System output, such as an error message or script
• URLs, complete paths, filenames, prompts, and syntax when shown 

outside of running text

Courier bold Used for specific user input, such as commands

Courier italic Used in procedures for:
• Variables on the command line
• User input variables 

< > Angle brackets enclose parameter or variable values supplied by the user 

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections — the bar means “or”

{ } Braces enclose content that the user must specify, such as x or y or z

... Ellipses indicate nonessential information omitted from the example
10 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide
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Technical support — For technical support, go to EMC Online Support and select Service 
Center. On the Support page, you will see several options, including one to create a 
service request. Note that to open a service request, you must have a valid support 
agreement. Contact your EMC sales representative for details about obtaining a valid 
support agreement or with questions about  your account.

Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:

techpubcomments@emc.com
EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide 11
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Installing PowerPath
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◆ PowerPath installation troubleshooting................................................................... 31
◆ Upgrading Windows operating systems................................................................... 32
◆ Unsupported installation changes........................................................................... 32
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Installing PowerPath
Before you install
The sequence of steps to configure a storage system and install EMC® PowerPath® or 
PowerPath/VE for Windows Hyper-V on a host depends on the storage system you use.

Note: Throughout this document, all references to PowerPath refer to PowerPath and 
PowerPath/VE for Windows Hyper-V, unless otherwise noted. PowerPath/VE for Windows 
Hyper-V provides the same multipathing functionality as PowerPath for Windows in 
nonvirtual environments, and it supports Migration Enabler.

EMC Symmetrix storage systems

Install PowerPath after you set up the EMC Symmetrix® storage system and verify that it is 
working properly.

EMC VNX and CLARiiON storage systems

PowerPath installation is an integral part of an EMC VNX™ Operating Environment (OE) 
and CLARiiON® setup and configuration procedure.

For information on when to install PowerPath on a host attached to a VNX or CLARiiON 
storage system, refer to the:

◆ VNX Storage-System Support website.

◆ CLARiiON Storage-System Support website. From the home page, select your storage 
system type, then use the Attach server link (CX4 systems) or the Install link (all other 
systems) to generate step-by-step instructions.

NetApp storage arrays

PowerPath reports NetApp ID in powermt output and in user interface only if the Report 
SCSI Name String Inquiry Descriptor setting is enabled for the initiator group through 
which host is connected to LUNs.

The setting is disabled by default for Windows-based initiator groups, and enabled by 
default for all the other operating system types. Use the following NetApp commands to 
check the current value of the setting:

igroup show -v igroup_name

For example, 

system1> igroup show -v <initiator group name>
<Initiator group name> (FCP):
OS Type: windows
Member: 10:00:00:00:c9:ac:58:ec (logged in on: vtic)
Member: 10:00:00:00:c9:ac:58:ed (logged in on: vtic, 1b)
UUID: 4e4eb665-fff8-11e2-98b7-123478563412
ALUA: Yes
Report SCSI Name in Inquiry Descriptor: Yes

Use the following command to enable report_scsi_name

igroup set igroup_name report_scsi_name yes
14 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide
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For a NetApp HA pair, the following property settings must be set for an initiator group 
before installing PowerPath:

◆ The report_scsi_name property must be enabled (set to yes) for both controllers of the 
pair.

◆ The ALUA property, set using the igroup command must be the same for two 
controllers of the pair, that is, it should either be yes or no for both the controllers.

Note: PowerPath is supported only with ALUA mode of operation for NetApp initiator 
groups.

For example,

igroup set  <ig name> alua yes

OR 

igroup set  <ig name> alua no

Obtain up-to-date information

Check the EMC Online Support website for current information:

❑ PowerPath documentation — EMC updates PowerPath documentation when it 
releases new features with a service pack or when documentation errors are 
reported.Service packs and upgrades — You can download PowerPath service pack 
software from EMC Online Support. Determine which service packs (if any) to install 
after PowerPath, and whether those service packs have any additional installation 
prerequisites.

Choose a convenient time

Installing PowerPath requires that you reboot the host. Plan to install or upgrade 
PowerPath when a reboot will cause minimal disruption to your site.

Activate your license 

PowerPath/VE for Windows Hyper-V and PowerPath for Windows require separate 
licenses. However, the licensing process for PowerPath/VE for Windows Hyper-V is the 
same as the licensing process for PowerPath for Windows.

The licensing process for both PowerPath/VE for Windows Hyper-V and for PowerPath for 
Windows is described in the EMC PowerPath Family Electronic License Ordering Process 
Technical Notes, available on EMC Online Support.

Take note of the following regarding licenses:

◆ If you are upgrading from an earlier version of PowerPath, you do not need to 
reregister. PowerPath will use your old key.

◆ PowerPath Migration Enabler does not require a separate product license. The 
PowerPath Multipathing license includes Migration Enabler functionality for all 
technology types (Host Copy, Open Replicator, TimeFinder/Clone, Encapsulation).
Before you install 15
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◆ Type the registration number exactly as it appears on the card or letter. To reduce 
common typographical errors, the License Key field accepts either uppercase or 
lowercase letters, and certain numbers and letters are interchangeable. Specifically, 
an entry of the alphabetic letters O, I, S, and B is equivalent to an entry of the 
numbers, 0, 1, 5, and 8.

Prepare the host and storage system

Prepare the host and storage system:

❑ Go to EMC Online Support and verify your environment meets the requirements found 
in the EMC PowerPath and PowerPath/VE Family for Windows Release Notes and the 
E-Lab™ Interoperability Navigator by running the PowerPath Configuration Checker 
(PPCC). For PPCC installation information, the EMC PowerPath Configuration Checker 
User Guide, available on EMC Online Support, provides additional information.

❑ The EMC PowerPath and PowerPath/VE Family for Windows Release Notes includes 
the qualified Microsoft MPIO framework versions.

❑ The EMC PowerPath and PowerPath/VE Family for Windows Release Notes includes a 
list of all Microsoft Hotfixes that are required to be installed, depending on your 
Windows Operating System, prior to installing PowerPath

❑ Configure HBA drivers. Ensure that you follow the HBA driver configuration guidelines 
outlined in the E-Lab Interoperability Navigator and the HBA vendor documentation. 
The use of improper settings can cause erratic failover behavior, such as greatly 
increased I/O delays.

❑ For hosts connected to storage arrays through a Fibre Channel switch (that is, a fabric), 
configure the HBAs by using persistent binding for SCSI target IDs.

Booting from a storage array device

The following documents provide instructions for configuring a storage array device as the 
boot device:

◆ EMC Fibre Channel with Emulex Host Bus Adapters in the Windows Environment, 
available on the Emulex website.

◆ EMC Fibre Channel and iSCSI with QLogic Host Bus Adapters in the Windows 
Environment, available on the QLogic website.

Preparing a cluster environment

Chapter 5, "PowerPath in an MSCS Cluster," provides information on installing PowerPath 
in a new or existing cluster.

Installing in virtual environments

The procedure to install PowerPath in virtual environments is the same as the procedure to 
install in physical environments. You can follow the GUI or the CLI installation procedure 
described in this document.

EMC supports iSCSI connections directly attached to EMC storage using the Microsoft 
Initiator in a child partition. In this configuration PowerPath is supported in a child 
partition to manage multiple iSCSI paths. However, pass-through disks are not supported 
when running EMC PowerPath.
16 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide
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Coexistence with third-party path management software

PowerPath can coexist with MPIO-based third-party path management software such as:

◆ Hitachi Dynamic Link Manager (HDLM)

◆ IBM Subsystem Device Driver (SDD)

◆ HP StorageWorks Secure Path

◆ HP StorageWorks AutoPath XP Virtual Array

◆ Microsoft MPIO (native multipathing)

◆ Veritas Dynamic Multipathing

PowerPath cannot co-manage devices with third-party path management software.

If multiple DSMs are installed to manage devices of an array, Microsoft MPIO framework 
currently does not ensure that a particular DSM will always manage such devices. As a 
result, the effects of using PowerPath DSM and another third-party DSM for managing the 
same array are undetermined. Further, when PowerPath coexists with other multipathing 
software to manage exclusive arrays, a HBA cannot be shared between the two. The 
Microsoft MPIO documentation provides more details. 

Before you upgrade or apply a service pack
Before upgrading PowerPath or installing a service pack:

1. Go to EMC Online Support and do the following:

a. Check for the most current information. EMC updates release notes periodically 
and posts them on EMC Online Support.

b. Download the latest version of EMC Reports, available on EMC Online Support, and 
then run the PowerPath Configuration Checker (PPCC).

c. Download the PowerPath software on EMC Online Support at Downloads and save 
it to your local directory.

2. Save the current PowerPath configuration.

• Run the powermt save command to ensure that you have saved the latest 
PowerPath configuration information.

or

• In PowerPath Administrator, right-click the root node and select All Tasks > Save 
Config as. Then specify a file name and click Save.

3. Stop powermt display if it is running.

4. Uninstall any PowerPath hot fixes on the host. Use Add/Remove Programs or Programs 
and Features to verify if hot fixes are installed.

5. If upgrading, review the information in "Supported upgrades" on page 25.

6. Install PowerPath.

7. If installing a service pack or patch, verify the configuration is correct and then save it. 
This ensures the configuration file is updated to the current format.
Before you upgrade or apply a service pack 17
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Note: PowerPath stores configuration information in a configuration file that may be 
loaded at boot time. When using the PowerPath Administrator, the configuration file 
can be saved only under the default filename. After a service pack is applied, the 
configuration file format may have changed, resulting in the configuration file no 
longer being backward compatible.

Installation procedures
You can install PowerPath for Windows with the default GUI method or through the CLI. 
Refer to one of the following procedures to install PowerPath.

Note: You must have administrative rights to install PowerPath.

◆ "Interactive GUI installation (default method)" on page 18

◆ "CLI installation" on page 20

PowerPath installation creates installation logs by default in 
%ProgramData%\EMC\PowerPath\logs.

Service pack and patch installations

For how to install a PowerPath service pack for Windows or a PowerPath Patch for 
Windows, see the following sections:

◆ "Installing a PowerPath Service Pack for Windows" on page 26

◆ "Installing a PowerPath Patch for Windows" on page 26

Interactive GUI installation (default method)

To install PowerPath with the default interactive prompts:

1. If the PowerPath executable file is saved on your local system, double-click the 
PowerPath executable file, or click Start and select Run.

In the Run window, browse to or enter the name of the PowerPath installation 
program: <drive>:\<PowerPath_pkg_name>

2.  Select the language for this installation from the list and click Next. 

Localized versions of the PowerPath installer are available in Brazilian Portuguese, 
Latin American Spanish, French, German, Italian, Japanese, Korean, and simplified 
Chinese.

3. In the setup wizard welcome window, click Next.

4. In the Custom Setup dialog box, select the features for installation. By default, 
Multipathing, Migration Enabler, Management Component, and support for EMC 
storage arrays are selected. Clear unwanted default features or select additional 
features (such as third-party storage arrays such as NetApp) and then click Next.

• To select or clear features, click the arrow and select the appropriate option from 
the drop-down menu:

– Will be installed on local hard drive
18 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide
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– Entire feature will be installed on local hard drive

– Entire feature will be unavailable

• Click Disk Usage to view the required and available space needed to install 
selected features.

• Use the Browse option to change the destination folder.

5. Click Next.

If you do not configure PowerPath Migration Enabler cluster resources during installation, 
you can still configure them later using the powermigcl command through CLI.

6. In case of PowerPath upgrade installation and if powermt custom file is found, the 
PowerPath installer provides an option to either keep or delete the existing 
powermt.custom file.

• In order for the upgrade installation to convert and keep the existing 
powermt.custom file, select Keep the custom configuration file.

• If you want to delete the existing powermt.custom file, select Delete the custom 
configuration file.

7. In the Ready to Install dialog box, click Install.

a. Select Persist path information in powermt custom configuration file.

Note: The persist path information option in the powermt custom configuration file is 
set to ON when the box is checked.

b. If PowerPath detects that files that need to be updated are currently in use, select 
one of the following options:

– Automatically close and attempt to restart applications.

– Do not close applications (A reboot will be required.)

If PowerPath does not detect files currently in use, proceed to Step d.

c. Click OK.

d. On the Windows Security dialog box, click Install to install the device software.

Optionally, select Always trust software from <device vendor>.

When prompted by the EMC Licensing Tool, type your 24-digit registration number 
in the License Key field, and then click Add. 

Note: 
— PowerPath for Windows and PowerPath/VE for Windows Hyper-V each require a 
separate license. The licensing procedure is the same for each.
— When upgrading PowerPath, the existing license key is saved and no input is 
required. 
— To enable additional array support, enter the license keys. Migration Enabler is 
enabled when you enter a valid multipathing license key.
Installation procedures 19
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e. Click OK.

8. In the installation Wizard Completed dialog box, to change the Management 
Component default settings, click Launch Management Component Configuration 
Utility. Click Finish. The Management Component is disabled by default.

If you do not launch the Management Component Configuration utility during 
installation, you can configure the Management Component later by going to Start > 
Programs > EMC > Configuration and selecting Management Component Configuration.

If you launched the Management Component Configuration utility, review the following 
parameters. The PowerPath Viewer Installation and Administration Guide provides 
more information.

• Ensure that Enable PowerPath Management Component is selected. It is selected 
by default.

• In the Port Number field, maintain the default and recommended port value of 
9083 or change the port value to a value between 49152 and 65535 if another 
application is already using the default port (9083).

• In the Heartbeat Interval field, maintain the default value of 10 minutes or change 
the heartbeat interval value to a value between 1 and 60. EMC recommends that 
the heartbeat interval be based on the number of hosts being managed.

• Click Disable Single Path Symmetrix GateKeeper Setup Warnings to maintain the 
default setting if you do not want Setup errors to be reported for Symmetrix 
gatekeeper devices that are configured with a single path. Otherwise, clear the 
check box if Symmetrix gatekeeper devices are multi-pathed in your data center.

Note: PowerPath supports both single-path and multi-path configured Symmetrix 
gatekeepers. Consult your network administrator for more information about your 
Symmetrix gatekeeper configuration.

• Click Use Windows perfmon for PowerPath PMI counters to make PowerPath 
performance metrics (PowerPath counters) available in the Windows Performance 
monitoring tools.

• To restore the default options, click Restore Default.

9. Click Yes to reboot now or No to reboot later.

10. (optional) If you installed Migration Enabler, and if you are not planning to use this 
feature, EMC recommends that you disable this service and change the Startup type to 
disabled.

11. When the host restarts, follow the instructions in "After you install or upgrade" on 
page 27.

CLI installation

To install PowerPath using the more advanced command line interface, follow these steps. 
Use spaces to separate multiple properties.

1. Use this command syntax to install PowerPath:
20 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide
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<drive>:\<PowerPath_pkg_name> <install_parameters> /v"<Property>=<Value>"

• For a silent installation, which does not require user input, use this syntax:

Note: Silent installation errors are logged in <logfile>, the location specified in the 
installation command. No error message appears in the PowerPath Administrator 
GUI.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> <Property>=<Value>"

• For an interactive installation, which requires user input, use this syntax:

<drive>:\<PowerPath_pkg_name> /v"/L*v <logfile> <Property>=<Value>"

Where:

– <drive> is the drive letter, for example, C.

– <PowerPath_pkg_name> is the PowerPath package name. For example, 
EMCPower.X64.signed.<version>.<build>.exe. Where <version> is the product 
version; for example, PowerPath 6.0.

– <install_parameters> is one or more parameters described in Table 1 on 
page 23.

– <logfile> creates the log file where the log message will be sent, for example, 
C:\logs\PPsetup.log.

– Ensure the specified directory exists within the specified path.

– <Property>=<Value> is one or more optional properties described under the /v 
parameter in Table 1 on page 23.

Examples: Silent installation

To install all default PowerPath features (Multipathing, Migration Enabler, 
Management Component, and support for EMC storage arrays) using the silent 
installation method and to also set the PowerPath license and disable reboot, enter:

Note: Silent installations include the /s parameters.

C:\EMCPower.X64.signed.<version>.<build>.exe /s /v"/L*v C:\logs\PPsetup.log 
LICENSENUM=0000-0000-0000-0000-0000-0000 NO_REBOOT=1"

Example: Interactive installation

To install PowerPath using the interactive CLI method and to set the PowerPath 
license, copy, and install PowerPath files to C:\Test folder, disable reboot, and install 
components to support IBM ESS and Hitachi storage arrays, enter:

C:\EMCPower.X64.signed.<version>.<build>.exe /v"/L*v C:\Install_IBM_HDS_NETAPP.log 
LICENSENUM=0000-0000-0000-0000-0000-0000 INSTALLDIR=C:\Test NO_REBOOT=1 
ADDLOCAL=IBM,HDS,NETAPP"

2. After installing PowerPath, restart the host and then follow the instructions in "After 
you install or upgrade" on page 27.
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If you performed a complete install, and you are not planning to use  PowerPath 
Migration Enabler, EMC recommends that you disable this service and change the 
Startup type to disabled.
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CLI parameters
Table 1 on page 23 describes command line parameters and options. 

Table 1  CLI parameters and properties  (page 1 of 3)

Parameter Description

/s Suppresses installation dialog boxes. Indicates a quiet installation (no user interaction).

/v Directs installation to pass the specified string (enclosed in quotes) to the Microsoft Installer (MSI).
Example:
/v"<Property>=<Value>"
Where:
<Property> and <Value> descriptions follow.

Property Value description

LICENSENUM=<number1,
[number2,...]>

Where <number1,[number2, ...]> must be a valid license or no 
license will be saved. Use commas to separate multiple entries.

Note: PowerPath for Windows and PowerPath/VE for Windows 
Hyper-V each require a separate license. The licensing procedure 
is the same for each.

INSTALLDIR=<path> Where <path> is the location to copy and install PowerPath files.
Examples: 
INSTALLDIR=C:\Test 
INSTALLDIR=C:\Program Files\EMC

Note: The default installation directory is 
<RootDrive>:\ProgramFiles\EMC.

NO_REBOOT=1 The value 1 specifies that the host will not reboot after PowerPath 
is installed.

Note: EMC recommends NO_REBOOT=1 so that you can manually 
restart at a convenient time.

AUTO_HOST_REGISTRATION=1 The value 1 specifies that the automatic host array registration is 
enabled. By default, it is enabled.
If you want to disable the automatic host array registration, you 
must specify the value 0.

UPGRADE_MPIO=1 The value 1 specifies to upgrade the existing MPIO framework. 
Include this property if an MPIO version earlier than the one 
supported is installed. PowerPath installation aborts if the host 
has a version of the MPIO framework earlier than the supported 
version.

XTREMIO_NATIVE_ONLY=1 The value 1 specifies to install support for XtremIO Versions 2.2 
and later for PowerPath Version 6.x
This parameter is required in case of silent upgrade, when you are 
upgrading from PowerPath 5.7.1 with generic XtremIO support 
installed to PowerPath 6.x, which supports only XtremIO Version 
2.2 and later.
Example:
EMCPower.X64.signed.<version>.<build>.exe /s /v” 
XTREMIO_NATIVE_ONLY=1 NO_REBOOT=1”
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ADDLOCAL=<feature> Where <feature> can be any combination of the following items. 
Use commas to separate multiple entries, for example: 
ADDLOCAL=IBM,HDS
• If you do not pass ADDLOCAL values during command line 

installation, then PowerPath multipathing, Migration Enabler, 
Management Component, and support for EMC storage arrays is 
installed by default. If you pass ADDLOCAL values only the 
features you select are installed with PowerPath multipathing. 

• In the case of an upgrade, if you do not pass ADDLOCAL values 
during command line installation, PowerPath installs the 
features based on the previous version configuration. For 
example, if your previous version has Migration Enabler, HPXP, 
and IBM features installed then PowerPath upgrade selects 
these features for installation by default.

• ALL = Complete installation. Installs support for all PowerPath 
features.

• ME = Migration Enabler (selected for installation by default)
• HA = Management Component (selected for installation by 

default)
• IBM = IBM ESS and XIV arrays
• CELERRA = EMC Celerra and VNXe arrays (selected for 

installation by default)
• HDS = Hitachi arrays
• HPXP = HP XP Active-Active arrays, and HP EVA arrays with 

firmware VCS 4.0 or later
• INVISTA = EMC Invista and VPLEX arrays (selected for 

installation by default)
• XTREMIO = EMC XtremIO arrays firmware Version 2.2 or later 

(selected for installation by default)
• NETAPP = NetApp arrays (FAS2240)

PX_DELETE_CUSTOM_CONFIGURATION=<
KEEP|DELETE>

The PowerPath installer provides an option to either keep or delete 
the existing powermt.custom file through GUI or CLI methods. By 
default, the existing powermt.custom file is preserved.
• KEEP = Keeps the existing powermt.custom file
• DELETE = Deletes the existing powermt.custom file
For example, the CLI method provides the parameter 
EMCPower.X64.signed.<version>.<build>.exe /s 
/v"PX_DELETE_CUSTOM_CONFIGURATION=DELETE 
NO_REBOOT=1".

FORCE_DRIVER_UPDATE=1 The value 1 will continue to install PowerPath and ignore the 
device manager check for any pending device installation or 
uninstallation activities.

PPME_CLUSTER_GROUP=Group1,Group2 • GROUP = Configures PowerPath Migration Enabler cluster 
resources for the specified cluster groups. You can use 
comma-separated values for multiple entries.

• NONE = No cluster groups will be configured for any cluster 
node. By default, this value is set.

• ALL = Configures PowerPath Migration Enabler cluster resources 
on all available cluster groups on the current node.

Table 1  CLI parameters and properties  (page 2 of 3)

Parameter Description
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Supported upgrades
Before upgrading, ensure your environment meets these requirements:

◆ Do not remove redundant cable connections from the array.

◆ "Upgrading Windows operating systems" on page 32 provides information on 
upgrading Windows operating systems that have PowerPath installed.

◆ Windows Server Core 2008 and later — If PowerPath is installed through the GUI on 
the core version, the license key dialog box will not appear. Use the emcpreg utility to 
add the license key before rebooting.

◆ Upgrade using either the interactive GUI or the interactive CLI method.

◆ Upgrading PowerPath in a boot-from-SAN environment — You can upgrade PowerPath 
in a boot from SAN environment using the same procedure you would use in other 
environments.

Upgrading PowerPath custom file conversion

When the powermt.custom file is stored in a location other than the default location, the 
custom file will not be converted when upgrading PowerPath. This may cause error 
messages to appear after upgrading to PowerPath and running powermt load. If you 
upgrade PowerPath without converting the powermt.custom file, you must recreate the 
settings in PowerPath 6.x

PERSIST_PATH_INFO=1 • The value 1 will set persist_path_info value to ON. The default 
is ON.

• The value 0 will set persist_path_info value to OFF.

IGNORE_HF_WARNING=1 The value 1 will set ignore_hf_warning value to ON and continue 
with the PowerPath installation even if the required Microsoft 
Hotfixs on the target host are missing.

USE_BINDING_ORDER=1 The value 1 with the use_binding_order parameter is used to fix 
incorrect IP address when performing auto host registration.

Note: When the next auto host registration is performed, the IP 
address of the first adapter in the binding order list will be used.

/L*v <logfile> Directs the Microsoft Installer to write verbose output to the file 
specified with this option. The target directory for the log file must 
exist before starting a silent installation by using the logging 
option (as required by the Windows installer engine).
On Windows Server 2008 and later MSI logs will be also available 
in: %ProgramData%\EMC\PowerPath\logs.

Note: These folders may be hidden in Windows Explorer.

/p Unattended installation which does not require any user interaction, but will have installation progress bar 
shown.
Example: 
<Drive>:\<PowerPath_pkg_name> /p /v"NO_REBOOT=1"

Table 1  CLI parameters and properties  (page 3 of 3)

Parameter Description
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In order for the upgrade to convert the powermt.custom file, perform the following before 
beginning the upgrade:

1. Copy the powermt.custom file to the default 
<PowerPath_Installation_Directory>\PowerPath directory.

2. During the upgrade, when prompted, select to keep the existing custom file.

After the upgrade and reboot, the settings saved in the powermt.custom file will be 
automatically loaded.

Note: Without persistent binding, the SCSI ID of a LUN may change, leading to ghost paths 
appearing during a host reboot with a saved custom file configuration. This may cause 
powermt to display misleading information. You may also see dead paths in case these 
paths have different SCSI IDs. In such cases, you will also see more paths per LU than 
what was actually configured in your SAN environment. Ghost paths can be avoided by 
setting the persist_path_info to OFF. The PowerPath CLI and System Messages Reference 
provides more information.

Installing a PowerPath Service Pack for Windows

To install a PowerPath for Windows service pack, follow the installation instructions in 
"Interactive GUI installation (default method)" on page 18 or in "CLI installation" on 
page 20. 

Installing a PowerPath Patch for Windows

Before the installation

◆ Ensure that the PowerPath base package is installed. The PowerPath base package 
must be installed on the host before you can install a PowerPath patch for Windows. 

PowerPath patches for Windows are not full package installations and will only update 
a specific set of files or drivers. Installation of the patch does not change the 
PowerPath version. 

◆ If the patch has fixes for additional PowerPath features (such as, Migration Enabler), 
then thatfeature must be enabled before you install the patch for the patch to be able 
to apply its fixes.

◆ A lower version patch can be applied on top of a higher version one (Multiple patches 
can be installed and can coexist). 

Patch Installation Procedure

To install a PowerPath for Windows patch, perform one of the following:

◆ Double click the patch executable file.

1. Double click the patch executable file.

2. Click Update in the Install Welcome dialog box.

3. Click Finish.

4. Click Yes to reboot the host or No to reboot later.
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◆ Use the command line.

<Patch.exe> /s /v"/q NO_REBOOT=1 /L*v C:\logs\Install_PP_Patch.log"

Note: EMC recommends NO_REBOOT=1 so that you can manually restart at a 
convenient time.

After you install or upgrade
This section describes post-installation tasks. 

First-time installations

If you are installing PowerPath for the first time on a host:

1. Power on the host. PowerPath is now fully configured, with multiple paths to logical 
devices.

2. If the environment is Fibre Channel, ensure zones are configured appropriately. The 
VNX and CLARiiON storage-system support websites and the host connectivity guides 
provide additional information.

3. If you have not already done so, check EMC Online Support for any service packs and 
install any required service packs.

Verify the configuration

To verify the configuration:

1. Power on the host. PowerPath is fully configured with multiple paths to logical devices 
and (if appropriate) correct zones when you boot.

2. Verify the correctness of your configuration by running the following at the command 
prompt: 

powermt display
powermt display dev=all
powermt display ports

Note: If PowerPath sees no devices, but the devices are seen by the operating system, 
verify that the devices are configured for PowerPath support.

Verifying a patch installation

Once a patch is installed, it is listed as a subentry under the EMC PowerPath entry in 
Add/Remove Programs or Programs and Features:

Using Add/Remove Programs or Programs and Features verify that the PowerPath patch 
appears in the list of updated programs:

◆ Click Show updates in Add/Remove Programs.

◆ Click View installed updates in Programs and Features.
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Upgrading from generic XtremIO to XtremIO version 2.2 and later

PowerPath provides support for either XtremIO Version 1.05 (installed as part of the 
PowerPath Version 5.7 SP1 package) or XtremIO Version 2.2 and later (installed as part of 
PowerPath Version 6.x package). You can either have XtremIO Version 1.05 or XtremIO 
Version 2.2 and later, but not both.

If you are upgrading from PowerPath Version 5.7 SP1 to PowerPath Version 6.x, and if 
generic XtremIO Version 1.05 support is installed as part of the 5.7 SP1 package.

Configure the PowerPath Management Pack for Microsoft Operations Manager

You can configure the PowerPath management daemon to remotely monitor specific 
PowerPath events. This feature is available in a separate software package available on 
EMC Online Support. The management daemon integrates with Microsoft Operations 
Manager and allows you to retrieve license and version information from remote 
PowerPath hosts. It also can generate alerts when paths or volumes remain dead for a 
configurable time frame. The EMC PowerPath Management Pack for Microsoft Operations 
Manager User Guide provides more information on configuring and using the management 
daemon.

Note: If you plan to enable and configure PowerPath Management Component (which 
comes included in the PowerPath for Windows package), you must manually remove any 
existing version of the PowerPath Management Component before installing or upgrading 
to the latest version of PowerPath.

Adding features to an existing installation
If PowerPath is installed on your host and you want to install additional features, such as 
PowerPath Migration Enabler or components to support third-party arrays, follow one of 
these procedures: 

◆ "Add features through the GUI" on page 28

◆ "Add features through the CLI" on page 29

Add features through the GUI

To add features to an existing installation using the GUI:

1. Using Add/Remove Programs or Programs and Features select the installed version of 
PowerPath and click Change.

2. In the Setup wizard welcome window, click Next.

3. Select Modify and click Next.

4. Select the feature you want to install from the drop-down menu.
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Note: 
—A selected feature displays a hard drive icon next to it. A red X indicates the feature 
is not selected.
—The icon next to each feature name indicates the feature’s install state. Click Help in 
the Custom Setup dialog box for more information about the icons.

5. Select the option to install the feature on the local hard drive and click Next.

6. Click Install.

7. Click Finish.

8. Click Yes to reboot now or No to reboot later.

Note: If the User Account Control (UAC) is configured in the Admin Approval mode, 
running the PowerPath setup program to change, repair, or to uninstall PowerPath 6.0 
using Add/Remove Programs or Programs and Features through the control panel 
results in multiple elevation prompts.

Note: If you are installing Migration Enabler or Management Component then a reboot 
is not required. However, installing these features with any other feature requires a 
reboot.

Add features through the CLI

To add features to an existing installation using the CLI method, use this command syntax:

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> LICENSENUM=<license_key> 
NO_REBOOT=1 ADDLOCAL=<feature>"

For example, to install XtremIO and Invista, type the following on a single line:

C:\EMCPower.X64.signed.<version>.<build>.exe /s /v"/L*v C:\logs\PPsetup.log 
LICENSENUM=0000-0000-0000-0000-0000-0000 NO_REBOOT=1 ADDLOCAL=XTREMIO,INVISTA"

When the NO_REBOOT=1 parameter is used, reboot manually after installation.

Note: If you are installing Migration Enabler or Management Component then a reboot is 
not required. However, installing these features with any other feature requires a reboot.

Table 1 on page 23 describes the parameters and options.

Repairing PowerPath installation 
After installing PowerPath, if any of the PowerPath functionality is broken, you can repair 
the installation to resolve those issues.

The repair re-installs PowerPath and modifies only those components of the application 
that are missing or broken. It also re-installs all PowerPath drivers.

Note: Repairing PowerPath requires that you reboot the host.
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Follow one of these procedures to repair PowerPath:

◆ "Repair PowerPath installation through the GUI" on page 30

◆ "Repair PowerPath installation through the CLI" on page 30

Repair PowerPath installation through the GUI

To repair PowerPath installation through the GUI:

1. Using Add/Remove Programs or Programs and Features, select the installed version of 
PowerPath and click Repair.

OR

2. Using Add/Remove Programs or Programs and Features, select the installed version of 
PowerPath and click Change.

a. In the Setup wizard welcome window, click Next.

b. Select Repair.

c. Click Repair.

d. Click Finish. 

3. Click Yes to reboot now or No to reboot later.

Note: If the User Account Control (UAC) is configured in the Admin Approval mode, 
running the PowerPath setup program to change, repair, or to uninstall PowerPath 6.0 
using Add/Remove Programs or Programs and Features through the control panel 
results in multiple elevation prompts.

Repair PowerPath installation through the CLI

To repair PowerPath installation using the CLI method, use this command syntax:

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> REINSTALL=ALL" 

For example:

C:\EMCPower.X64.signed.<version>.<build>.exe /s /v"/L*v C:\logs\PPrepair.log 
REINSTALL=ALL NO_REBOOT=1"

When the NO_REBOOT=1 parameter is used, reboot manually after installation.
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PowerPath installation troubleshooting
Table 2 on page 31 lists PowerPath installation troubleshooting scenarios.

Table 2  Troubleshooting your installation 

Problem Error message Suggested action

PowerPath drivers may be present on a 
host where a PowerPath package has 
been uninstalled.

Incompatible files from a 
previous PowerPath version exist 
on the host. PowerPath recommends 
running PPRemoveAll with a reboot 
and then proceed with the 
PowerPath installation process. 
Run PPRemoveAll now?

Perform the following:
1. Choose Yes to run PPRemoveAlla. 

Otherwise, choose No and run the 
PPRemoveAll utilitya manually.

2. Reboot the host.

3. Install PowerPath.

Upgrade of PowerPath may fail because 
PowerPath drivers are missing on the 
host.

PowerPath detected a problem that 
is blocking the upgrade. Contact 
EMC Customer Support for 
assistance.

Perform the following:
1. Run the PPRemoveAll utility to remove 

PowerPath.

2. Reboot the host.

3. Install PowerPath.

Note: If the installation is still blocked, 
contact EMC Customer Support.

Upgrade of a PowerPath driver may fail. The PowerPath upgrade could not 
complete. PowerPath recommends 
running PPRemoveAll with a reboot 
and then proceed with the 
PowerPath installation process. 
Run PPRemoveAll now?

Perform the following:
1. Choose Yes to run PPRemoveAlla. 

Otherwise, choose No and run the 
PPRemoveAll utilitya manually.

2. Reboot the host.

3. Install PowerPath.

Installation of a PowerPath driver may 
fail.

PowerPath encountered a problem 
installing drivers and will roll 
back the installation changes. 
Contact EMC Customer Support for 
assistance.

Contact EMC Customer Support.

One of more PowerPath drivers may 
require a host reboot.

One or more PowerPath drivers 
require a host reboot. Reboot the 
host and then proceed with the 
PowerPath installation process.

Reboot the host and then install 
PowerPath.

One or more PowerPath drivers 
require a host reboot. Reboot the 
host, and retry the repair.

Reboot the host and then try driver repair 
again.

Repair of a PowerPath driver fails. The PowerPath repair operation 
could not complete. Contact EMC 
Customer Support for assistance.

Contact EMC Customer Support.

PowerPath failed to enable MPIO. PowerPath installation failed to 
enable MPIO feature on Windows 
server 2008 or later host.

Contact EMC Customer Support.

a. The PPRemoveAll utility removes all PowerPath multipathing entries from the host. Use this option only when you encounter a problem with an 
existing installation or attempt a removal.
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Upgrading Windows operating systems
You can upgrade your Windows operating system to a major release (from Windows Server 
2003/2003 R2, to Windows Server 2008/2008 R2 or Windows Server 2012/2012 R2) or 
to its service pack.

Note: The EMC E-Lab Interoperability Navigator and the EMC PowerPath and PowerPath/VE 
for Windows Release Notes provide information on the required service packs on different 
operating systems, supported versions of PowerPath, and any other system information 
that may apply to the operating system you plan to install.

Upgrading to Windows Server 2008 and later

When upgrading the operating system in one of the following scenarios:

◆ From Windows Server 2003/2003 R2 (with PowerPath installed) to Windows Server 
2008/2008 R2 or Windows Server 2012/2012 R2

◆ From Windows Server 2008 (with PowerPath installed) to Windows Server 2008 R2 or 
Windows Server 2012

◆ From Windows Server 2008 R2 (with PowerPath installed) to Windows Server 2012

The Windows operating system migration agent does not re-install most PowerPath drivers 
during the upgrade. After the upgrade, all PowerPath functionalities are disabled. When 
upgrading in a boot-from-SAN environment, the operating system upgrade may fail and 
the system may not reboot. This issue is also documented in EMC Knowledgebase 
Solution emc221704.

Procedure
To upgrade the Windows operating system:

1. Remove PowerPath.

2. Upgrade the Windows operating system.

3. Install PowerPath.

The EMC PowerPath and PowerPath/VE Family for Windows Release Notes provides 
additional information.

Installing Windows operating system service packs

You do not need to uninstall PowerPath before installing an operating system service pack 
such as Windows Server 2008 SP1 on a Windows Server 2008 host.

Unsupported installation changes
This section describes unsupported installation changes.
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Host reboot after installation changes

Uninstalling an earlier version of PowerPath without rebooting, and then installing a newer 
version may cause a system crash. To avoid this issue, reboot after installing, uninstalling, 
or upgrading PowerPath.

Note: When the system is not rebooted after installing, uninstalling, or upgrading 
PowerPath, the operating system confuses the uninstallation of old drivers with the 
installation of new drivers, causing a system panic.

Downgrading PowerPath

Do not attempt to install an earlier version of PowerPath on hosts currently running a more 
recent version of PowerPath. If you want to run an earlier version of PowerPath, you need 
to downgrade PowerPath.

To downgrade PowerPath:

1. Uninstall the newer version of PowerPath.

2. Restart the host.

3. Install the earlier version of PowerPath.
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Configuring PowerPath

This chapter includes the following sections:

◆ Introduction............................................................................................................  36
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◆ Removing some paths to PowerPath logical devices ................................................  39
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Introduction
You must reconfigure PowerPath after making configuration changes that affect 
host-to-storage-system connectivity or logical device identification. 

For example:

◆ Fibre Channel switch zone changes

◆ Adding or removing Fibre Channel switches

◆ Adding or removing HBAs or storage-system ports

◆ Adding or removing logical devices

◆ Redeploying existing logical devices

Note: If you do not reconfigure PowerPath after making configuration changes, many of 
these changes are treated as unintentional, and PowerPath tries to prevent them from 
affecting applications.

Many platform-specific and some PowerPath reconfiguration operations will fail if the 
affected logical devices are in use (either just marked alive or with I/O in progress). This is 
noted in the appropriate places in the procedures that follow.

After any reconfiguration, you must monitor the outcome of individual reconfiguration 
steps and confirm that the resulting changes are as expected, before relying on the new 
configuration. Otherwise, some paths may not be as expected.

Whenever you make any modification to the default settings, such as changing the default 
load-balancing policies, then you must run the powermt save command to ensure that the 
new settings persist across reboot.

Adding new paths to a PowerPath logical device
This procedure adds new paths to a logical device already configured (with at least one 
path) in PowerPath. 

This procedure can be done without interruption to running applications on Microsoft 
hosts.

All operations must succeed for the reconfiguration to be successful. If any step fails, 
resolve that issue before proceeding. Do not use the new configuration until the entire 
procedure completes successfully.

Path limit
Do not configure more than 32 paths per logical device.

Procedure
To add paths to a PowerPath logical device:

1. Run powermt display to confirm the current configuration. 
36 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide



Configuring PowerPath
2. Run powermt display dev=all to confirm the configuration of the logical devices to 
which new paths will be added. 

3. Ensure that the number of logical devices, hardware paths, and I/O paths are as 
expected. The path state should be alive for known good paths and dead for known 
bad paths. 

If there is a problem, correct it before proceeding.

4. Make physical path additions as required:

a. Map the logical device to additional storage-system ports.

b. Add new HBAs. For details, refer to your vendor documentation.

c. Attach cables.

d. Rezone Fibre Channel switches.

5. If using SAN Manager, Volume Logix, or Access Logix, make new paths available to the 
host using those tools.

6. Scan for hardware changes in the device manager or alternately, reboot. In some 
cases, the operating system may prompt for a reboot after new devices are added.

7. Reconfigure PowerPath.

8. Inspect the new PowerPath configuration:

a. Run powermt display dev=all.

The new paths should be displayed with a state of alive.

b. Run powermt restore to test all paths.

c. Scan operating system error logs to ensure no errors are logged against the new 
paths.

9. Correct any issues detected.

10. Run powermt save to save the new configuration.

Adding new logical devices to the PowerPath configuration
This procedure adds new logical devices (with one or more paths) to be managed by 
PowerPath and applies to managed storage system classes only.

Logical devices can be added without interruption of service, since no existing application 
can be using a logical device that is not yet available.

After successful configuration, new pseudo devices can be used.

All operations must succeed for the reconfiguration to be successful. If any step fails, 
resolve that issue before proceeding. Do not use the new configuration until the entire 
procedure completes successfully.

Procedure
To add logical devices to the PowerPath configuration:
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1. Run powermt display to confirm the current configuration. Ensure that the number of 
logical devices, hardware paths, and I/O paths are as expected. The path state should 
be alive for known good paths and dead for known bad paths.

2. Make logical device and physical path changes as required:

a. Create new logical devices.

b. Map logical devices to one or more storage-system ports.

c. Add new HBAs. For details, your vendor documentation will provide more details.

d. Attach cables.

e. Rezone Fibre Channel switches.

3. If using SAN Manager, Volume Logix, or Access Logix, make new paths available to the 
host using those tools.

4. Scan for hardware changes in the device manager. Alternately, reboot. In some cases, 
the operating system may prompt for a reboot after new devices are added.

5. Reconfigure PowerPath.

6. After adding LUNs to a storage group and scanning the disk via the device 
manager/diskpart scan operation or through a reboot, the powermt display dev=all 
command may return an error count of 1 for the new LUNs. For example, if there are 4 
paths configured between the host and the array, PowerPath will display 4 errors 
against each LUN, one error for each path.
Run the powermt restore command to reset the error count to 0.

Note: When a new path is added to the Windows host, the system restarts the 
corresponding path device to complete the software installation, resulting in a path dead 
message in the system log which can be ignored.

7. Inspect the new PowerPath configuration:

a. Run powermt display dev=all.

All paths associated with the new logical devices should be displayed with a state 
of alive.

b. Run powermt restore to test all paths to the new logical device.

c. Scan operating system error logs to ensure no errors are logged against the new 
paths and logical device.

8. Correct any issues detected, before saving the PowerPath configuration or using the 
new logical device.

9. Set PowerPath-specific options for the new logical devices, such as load-balancing 
and failover policy, path modes, write throttle enablement, and priority.

10. Reconfigure PowerPath. 

11. Run powermt save to save the new configuration.

12. On the host where EMC ControlCenter is installed, run the command that refreshes the 
ControlCenter database of device information. Refer to the documentation for your 
version of ControlCenter.
38 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide



Configuring PowerPath
Removing some paths to PowerPath logical devices
This procedure removes some (but not all) paths to logical devices configured in 
PowerPath.

Do not remove the last live path to a logical device unless you plan to remove the logical 
device entirely, as data access will be interrupted. If a PowerPath device is open, 
powermt remove does not remove that device or the last path to that device.

Note: Failure to follow all the steps in this procedure properly can result in data loss and 
errors that affect the operating system.

Procedure
To remove some paths to PowerPath logical devices:

1. Run powermt display dev=all to confirm the configuration of the logical devices from 
which paths will be removed.

2. Check the number of existing paths.

The path state should be alive for known good paths and dead for known bad paths.

3. If there is a problem, correct it before proceeding.

4. Identify the physical paths to be removed or zoned out, and confirm that there are 
other paths to the affected logical devices. (Otherwise, applications using those 
logical devices could experience I/O errors when you proceed.)

5. Run powermt display dev=all to identify the PowerPath HBA number associated with 
the paths to be removed. In complex topologies, there can be multiple paths on an 
HBA.

6. Run powermt set mode=standby to set the mode to standby for all paths to be 
removed. If an HBA is to be removed, specify the HBA (instead of the device) when 
running powermt set mode.

7. Physically disconnect the paths or logically disconnect them by removing them from 
active zones.

As a result of this, the operating system may log some error messages. However, 
PowerPath prevents these errors from affecting applications.

8. Scan for hardware changes in the device manager. Alternately, reboot. In some cases, 
the operating system may prompt for a reboot after new devices are added.

9. Run powermt restore, and confirm that the paths listed as dead are the ones you 
intended to remove.

10. Run powermt remove, specifying both the hba and dev arguments.

If you do not specify the hba argument, all paths to the specified logical device are 
removed.
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11. Remove HBAs as required and reboot if needed.

12. Inspect the new PowerPath configuration:

a. Run powermt display.

The output should show fewer total paths than before. All paths should have a 
state of optimal.

b. Run powermt display dev=all.

All remaining paths associated with the affected logical devices should be 
displayed with a state of alive.

13. Correct any issues detected before saving the PowerPath configuration or using the 
new logical devices.

14. Run powermt save to save the new configuration.

Removing PowerPath logical devices
This procedure removes logical devices (with all configured paths to those logical devices) 
configured in PowerPath. Logical devices can be removed without interruption of service 
only if no applications are using or configured to use the logical devices you are removing.

The procedure may fail if any application is using a device associated with the path to be 
removed.

Procedure
To remove PowerPath logical devices:

1. Inspect the current PowerPath configuration:

a. Run powermt display to confirm the current configuration. Ensure that the total 
number of logical devices, hardware paths, and I/O paths are as expected.

Since one or more paths may have failed, not all paths may be listed as optimal.

b. Run powermt display dev=all to confirm the configuration of the logical devices 
that will be removed. 

c. Check the number of existing paths. 

The path state should be alive for known good paths and dead for known bad 
paths.

2. If either of the above displays indicates a problem, correct it before proceeding.

3. Identify the logical devices to be removed.

4. Identify the physical paths that also may be removed.

5. Run powermt display dev=all to identify the PowerPath HBA number associated with 
the paths to be removed. In complex topologies, there can be multiple paths on an 
HBA.

6. Reconfigure all applications that are using the logical devices to be removed, so they 
are no longer configured to use them.

7. Unmount file systems.
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8. Remove the volume groups using the appropriate volume manager command.

9. Scan for hardware changes in the device manager. Alternately, reboot.

10. If using SAN Manager, Volume Logix, or Access Logix, remove access to the logical 
devices to be removed, using those tools.

As a result of this step, the operating system may log some error messages. These are 
expected and are harmless.

11. Run powermt remove dev=all. 

12. Run powermt save.

13. Disconnect physical paths or zone out paths with switched fabric zone changes as 
required.

14. Run powermt restore, and confirm that the paths listed as dead are associated with 
the logical devices you intend to remove.

15. Depending on the type of HBA installed, scan for hardware changes in the device 
manager. Alternately, reboot.

In some cases, the operating system may prompt for a reboot after new devices are 
added.

16. Inspect the new PowerPath configuration:

a. Run powermt display.

The output should show fewer total paths than before. All paths should have a 
summary state of optimal.

b. Run powermt display dev=all.

All remaining paths associated with the affected logical devices should be 
displayed with a state of alive.

17. Correct any issues detected above, before saving the PowerPath configuration or using 
the new logical devices.

18. Run powermt save to save the new configuration.

Configuring the Microsoft iSCSI Initiator for PowerPath
To configure the Microsoft iSCSI initiator for PowerPath select Enable multi-path while 
creating sessions on the target and then click OK. On Windows Server 2008 and later, the 
Microsoft iSCSI initiator is available by default. 

Note: Also refer to the recommended array and hardware guidelines.

Adding PowerPath PMI counters to Windows Performance Monitor
Path Management Insight (PMI) capabilities help performance monitoring by 
characterizing I/O patterns and diagnosing I/O problems. 
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The PMI counter and timers on the Performance Monitor framework is published by the V2 
Performance Counter provider. The provider which is hosted by the PowerPath 
Management Service, is part of the PowerPath Management Component and is enabled by 
default. 

Each PMI counter and timer is present in the perfmon. Two specific PowerPath PMI 
counters are displayed as part of the Windows Performance Monitoring tools under 
Performance\Performance Tools\Performance Monitor. These independent counters are 
also listed in the Add Counters wizard and display the following information: 

◆ PowerPath Volume PMI Data — contains all counters and timers for Volumes

◆ PowerPath Path PMI Data — contains all counters and timers for Paths

Collection of data does not start until the powermt set perfmon=<On> command is set. 
Setting the perfmon command to On initializes the performance monitoring counter and 
measurements. Apart from powermt set perfmon, there are two more commands that can 
be used to collect insights for enhanced performance information:

◆ powermt display perf dev

◆ powermt display perf bus

The output of these commands provide:

◆ Read, Write, and Total Throughput 

◆ Read, Write and All Average Response Time

◆ Latency Distribution

◆ Retry delta

◆ Error delta

For more information on these CLI commands, see the EMC PowerPath Family CLI and 
System Messages Reference Guide.

For more information on adding counters, refer to Microsoft Performance Monitoring 
documentation.
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Before you remove PowerPath
Before you remove PowerPath from the host:

❑ Check EMC Online Support for the most current information. EMC updates release 
notes periodically and posts them on EMC Online Support.

❑ Stop any application actively sending I/O. In addition, close any remaining 
applications and client files to avoid warning messages when rebooting after the 
uninstall.

Note: If you try to uninstall PowerPath when there are active migrations, the message 
"Migration(s) is (are) pending" appears and the uninstallation process aborts. Contact 
EMC Customer Support if you see the message “An internal error has occurred. 
Migrations may be pending.” 

Removing PowerPath software or components

You can remove PowerPath and all related components, or you can remove a specific 
feature, such as Migration Enabler. You can also remove specific multipathing 
components you may no longer need, such as components to support third-party arrays.

You can use the Windows Add/Remove Programs or Programs and Features tools to 
remove PowerPath, or you can use the more advanced PowerPath command line interface. 
Use one of these methods to uninstall PowerPath software or features.

◆ "Uninstalling PowerPath with Windows OS tools" on page 44

◆ "Uninstalling with the PowerPath command line" on page 46

Note: EMC recommends that you reboot after removing PowerPath.

Uninstalling PowerPath with Windows OS tools
The procedures in this section describe how to uninstall PowerPath software or 
components using Windows operating system tools.

◆ "Complete PowerPath removal" on page 45 removes PowerPath multipathing and 
makes other PowerPath features unavailable for installation changes through the 
Windows GUI. Future installation changes can only be made through the PowerPath 
executable file or the PowerPath CLI once you complete this procedure.

◆ "Feature-specific removal" on page 45 removes specific PowerPath features, such as 
Migration Enabler, Management Component, or components that provide support for 
third-party arrays.

◆ "PowerPath for Windows Patch removal" on page 46 removes specific PowerPath 
patches.
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Complete PowerPath removal

Use this procedure to completely remove PowerPath.

1. Using Add/Remove Programs or Programs and Features uninstall the installed version 
of PowerPath.

For Windows Server 2008 and later:

• If User Account Control (UAC) is turned on, click Yes on the elevation.

• If you belong to the Administrative group, click Allow in the elevation.

• If you are a standard user, give the administrative credentials to uninstall.

2. When prompted to remove PowerPath, click Yes.

3. When prompted to reboot the host, click No to reboot later. 

Note: You can reboot after disconnecting redundant cables.

4. Complete the steps in "Disconnecting redundant paths to the storage system" on 
page 50.

Feature-specific removal

Use this procedure to remove specific PowerPath features.

Note: You cannot uninstall PowerPath multipathing for EMC arrays using this procedure. 
Only the complete uninstall procedure removes default multipathing components.

1. Using Add/Remove Programs or Programs and Features select the installed version of 
PowerPath and click Change/Remove.

2. In the setup wizard welcome window, click Next.

3. Click Change.

4. To select a feature to uninstall, such as Migration Enabler or the Management 
Component, click the drop-down arrow beside the feature on the Custom Setup dialog 
box:

Note: 
—A selected feature displays a hard drive icon next to it. A red X next to it indicates 
features that are not selected.
—The icon next to the feature name indicates the install state of the feature. Click Help 
in the Custom Setup dialog box for more information about the icons.

a. Select Entire feature will be unavailable.

b. Click Next.

5. In the Ready to Change EMC Powerpath 6.X.(xxbit) click Change.

6. Click Finish.

7. When prompted to reboot the host, click No to reboot later. Feature removal (other 
than the Management Component) needs reboot.
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If you removed multipathing support for any storage systems, complete the steps in 
"Disconnecting redundant paths to the storage system" on page 50.

PowerPath for Windows Patch removal

Note: Uninstalling a base PowerPath package will uninstall any related patches as well. For 
example, uninstallation of PowerPath 6.0 will uninstall any corresponding PowerPath 6.0 
patches as well.

Uninstalling a PowerPath for Windows patch using Add/Remove Programs or Programs and Features 
panel

1. If the PowerPath Administrator is running, close it.

2. Close all applications.

3. Open the Control Panel and then select Add/Remove Programs or Programs and 
Features.

4. Display the installed PowerPath patch you want to remove by clicking Show updates or 
View installed updates.

5. Select the specific PowerPath patch you want to remove, and click Remove.

6. Click Yes to remove the PowerPath patch.

7. Click Yes to restart the host.

Uninstalling with the PowerPath command line
The command line method allows you to uninstall PowerPath multipathing and/or other 
features, such as Migration Enabler or PowerPath Encryption.

Use this procedure for complete PowerPath removal or for feature-specific removal.

1. Use this command syntax to uninstall PowerPath:

<drive>:\<PowerPath_pkg_name> <uninstall_parameters> /v"<Property>=<Value>"

• For a silent removal, which does not require user input, use this syntax:

Note: Silent uninstallation errors are logged in <logfile>, the location specified in 
the uninstallation command. No error message appears in the PowerPath 
Administrator GUI.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> <Property>=<Value>"

• For an interactive removal, which requires user input, use this syntax:

<drive>:\<PowerPath_pkg_name> /v"/L*v <logfile> <Property>=<Value>"

Where:

– <drive> is the drive letter, for example, C.
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– <PowerPath_pkg_name> is the PowerPath package name. For example, 
EMCPower.X64.signed.6.x.<build>.exe. Where 6.x is the PowerPath for Windows 
release version; for example, PowerPath 6.0.

– E<uninstall_parameters> is one or more parameters described in Table 3 on 
page 48.

– <logfile> creates the log file where the log message will be sent, for example, 
C:\logs\PPsetup.log.

Note: Make sure the specified directory exists within the specified path.

– <Property>=<Value> is one or more optional properties described under the /v 
parameter in Table 3 on page 48.

Example: Silent removal

The following example of a silent uninstall completely removes PowerPath. It also 
disables reboot.

C:\EMCPower.X64.signed.6.x.<build>.exe /s /v"/L*v C:\logs\PPremove.log NO_REBOOT=1 
PPREMOVE=CLEAN"
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Example: Interactive removal

The following example of an interactive uninstall disables reboot and removes 
components to support HP XP and Hitachi arrays.

C:\EMCPower.X64.signed.6.x.<build>.exe /v"/L*v C:\Uninstall_HPXP_HDS.log NO_REBOOT=1 
PPREMOVE=HPXP,HDS"

The following example of an interactive uninstall removes only PowerPath Migration 
Enabler:

C:\EMCPower.X64.signed.6.x.<build>.exe /v"/L*v C:\logs\Uninstall_PPME.log NO_REBOOT=1 
PPREMOVE=ME"

The following example should be used only in case if you encounter a problem with 
normal PowerPath uninstallation (interactive/silent uninstallation).

Note: EMC recommends using the PPREMOVE=CLEAN option as command line 
uninstall option (for complete removal of PowerPath).

The /r parameter replaces PPREMOVE=ALL. By default, a bootstrapper log is created in 
%ProgramData%\EMC\PowerPath\logs. Adding the /L*v <logfile> parameter does not 
create a log file when using the PPRemoveAll utility.

C:\EMCPower.X64.signed.6.x.<build>.exe /r

2. After uninstalling, complete the steps in "Disconnecting redundant paths to the 
storage system" on page 50.

CLI parameters Table 3 on page 48 describes the CLI parameters and properties.

Table 3  CLI parameters and properties  (1 of 2)

Parameter Description

/s Suppresses installation dialog boxes. Indicates a quiet removal (no user interaction).

/v Directs installation to pass the specified string (enclosed in quotes) to the Microsoft Installer (MSI).
Example:
/v"<Property>=<Value>"
Where:
<Property> and <Value> descriptions follow.

Property Value description

NO_REBOOT=1 The value 1 specifies that the host will not reboot after PowerPath is installed.

Note: EMC recommends NO_REBOOT=1 so that you can manually restart at a 
convenient time.
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PPREMOVE=<feature> Specifies the features to uninstall. Use commas to separate multiple entries, 
for example: PPREMOVE=ME, INVISTA
• CLEAN = Removes PowerPath and all other features, such as Migration 

Enabler and PowerPath Encryption. It also removes driver files and 
corresponding registry entries.

• ME = Migration Enabler
• HA = Management Component
• IBM = IBM  ESS and XIV arrays
• CELERRA = EMC Celerra and VNXe arrays
• HDS = Hitachi arrays
• HPXP = HP XP Active-Active arrays, and HP EVA arrays with firmware VCS 

4.0 or later
• INVISTA = EMC Invista and VPLEX devices
• XTREMIO = EMC XtremIO arrays firmware Version 2.2 or later
• NETAPP = NetApp arrays

FORCE_DRIVER_UPDATE=1 The value 1 will continue to install PowerPath and ignore the device manager 
check for any pending device installation or uninstallation activities.

/L*v <logfile> Directs the Microsoft Installer to write verbose output to the file specified with 
this option. The target directory for the log file must exist before starting a 
silent removal by using the logging option (as required by the Windows 
installer engine). 
On Windows Server 2008 and later MSI logs will be also available in: 
%ProgramData%\EMC\PowerPath\logs.
The PPRemoveAll utility does not create a logfile when using the /L*v 
parameter. Instead, a bootstrapper log is created by default in 
%ProgramData%\EMC\PowerPath\logs.

/r
Notice: Contact EMC Customer Support before using /r.

Use this option only when you encounter a problem with either installation or uninstallation of PowerPath.

This invokes the PPRemoveAll utility, which removes all PowerPath multipathing entries from the host. . This /r 
switch replaces PPREMOVE=ALL.

Note: You do not need any of the above parameters with the /r switch.

/p Unattended uninstall that does not require any user interaction, but will have an installation progress bar 
displayed.
Example: 
<Drive>:\<PowerPath_pkg_name> /p /v"PPREMOVE=<feature1>, <feature2>, .. NO_REBOOT=1"

Table 3  CLI parameters and properties  (2 of 2)

Parameter Description
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PowerPath uninstallation troubleshooting
Table 4 on page 50 lists PowerPath uninstallation troubleshooting scenarios.

Disconnecting redundant paths to the storage system
After uninstalling PowerPath, disconnect redundant paths to the storage system.

Data corruption is possible if multiple paths remain on a system after PowerPath is 
removed. 

To disconnect redundant paths:

1. In the Shut Down Windows dialog box, select Shut Down from the list, and click OK.

2. With the host shut down, disconnect redundant cables from the HBAs to the storage 
system interface ports.

Note: SAN (fabric) configurations may have multiple logical configurations per 
physical connection. Ensure that no redundant zoned paths exist.

3. Restart the host. PowerPath is completely removed from the host.

Table 4  Troubleshooting scenarios 

Problem Message Suggested action

Uninstalling PowerPath in a 
boot-from-SAN configuration on a host 
that has Windows Server 2008 R2 or later 
requires two host reboots.

PowerPath cannot disable some of 
its devices because a page file 
is located in a LUN under 
PowerPath control or host is 
configured to boot from SAN. 
Under these scenarios, two host 
reboots are required to uninstall 
PowerPath. Click OK to proceed, 
or Cancel to exit.

1. Go to Control Panel and select 
Add/Remove Programs.

2. Select PowerPath from the list of 
programs.

3. Click Remove.

4. Reboot the host.

5. Repeat steps 1 through 3. 

6. Reboot the host.

MPIO is ready to be uninstalled in a 
boot-from-SAN configuration.

PowerPath has prepared the system 
for uninstallation. You must 
restart your system and continue 
with PowerPath uninstallation.

1. Go to Control Panel and select 
Add/Remove Programs.

2. Select PowerPath from the list of 
programs.

3. Click Remove.

4. Reboot the host.

5. Repeat steps 1 through 3.

6. Reboot the host.
50 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide



CHAPTER 4
Managing PowerPath

Invisible Body Tag

This chapter includes the following sections:

◆ Overview................................................................................................................. 52
◆ PowerPath Monitor.................................................................................................. 52
◆ PowerPath registration tools ................................................................................... 53
◆ PowerPath Administrator......................................................................................... 54 
◆ Local or remote administration................................................................................ 58
◆ Saving and loading Administrator settings .............................................................. 60
◆ Saving MMC console settings.................................................................................. 61
◆ PowerPath and Systems Management Server (SMS) ................................................ 61
◆ Traybar and UAC modifications................................................................................ 62
◆ Audit and error log messages.................................................................................. 62
Managing PowerPath 51



Managing PowerPath
Overview
The PowerPath Administrator graphical user interface for Windows Server consists of two 
applications:

◆ PowerPath Monitor — Continuously monitors your PowerPath configuration and alerts 
you of status changes. The "PowerPath Monitor" section provides additional 
information.

◆ PowerPath Administrator — Configures, monitors, and manages PowerPath devices. 
The "PowerPath Administrator" on page 54 provides additional information.

PowerPath Monitor
PowerPath Monitor (on the taskbar of your Windows desktop) continuously monitors the 
status of your PowerPath configuration. PowerPath Monitor can be set to alert you with 
visual and audible cues when the status changes.

For example, if a path fails, the icon changes accordingly as seen in Table 5 on page 52. 
Depending on the Notification settings you choose on the Options tab of the EMC 
PowerPath Admin (root node) Properties dialog box (see PowerPath Administrator online 
help for Windows Server), PowerPath Monitor may: 

◆ Sound an alarm. 

◆ Restore the PowerPath Administrator main window. 

◆ Flash the taskbar icon. 

◆ Or any combination thereof.

Table 5 shows the taskbar icons and the status each represents.

Table 5  PowerPath Monitor taskbar icons

Taskbar 
Icon Status

Optimal — All configured paths are operating properly.

Degraded — Some but not all paths have failed.

All Failed — All configured paths have failed.

Server Not Responding — Cannot communicate with Monitor 
service. This occurs if the PowerPath Administrator Suite 
encountered errors during initialization.
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Note: All non-optimal monitor icons appear only if you have selected the Flash Taskbar 
Icon on the Options tab of the EMC PowerPath Admin (root node) Properties dialog box. 
The root node is the top-level view of your configuration and represents the host that is 
being managed by PowerPath.

Launching MMC with the PowerPath snap-in

You can use PowerPath Monitor to do the following:

◆ Launch Microsoft Management Console (MMC) with the PowerPath snap-in.

◆ Notify you of PowerPath status changes if you are running it on a local host.

Note: The EMC PowerPath Administrator Monitor monitors the local host only. It does not 
remotely monitor the status of another host. The icon is only present on the Windows 
taskbar on the host with EMC PowerPath Administrator installed. If you are running 
PowerPath for the first time on a remote host, you must start the application according to 
the instructions at "Local or remote administration" on page 58.

To launch the Microsoft Management Console (MMC) with the PowerPath Snap-in, do one 
of the following:

◆ Double-click the PowerPath Monitor icon on the Windows taskbar to launch the 
default MMC console with the PowerPath Snap-in.

or

◆ Right-click the PowerPath Monitor icon to display the following context menu options:

• PowerPath Administrator — Launches PowerPath Administrator.

• Close Monitor — Closes the EMC PowerPath Administrator Monitor.

PowerPath registration tools
You can use the PowerPath Licensing Tool or the emcpreg command to register PowerPath 
and related products.

PowerPath Licensing Tool

The Licensing Tool is used to register PowerPath and other products, from the Windows 
GUI. The Licensing Tool is displayed during PowerPath installation. To manage licenses, 
you can launch the tool by selecting Start > All Programs > EMC > PowerPath Licensing Tool.

This tool allows you to add or remove licenses. For more information, see the online help 
(press F1) or launch the help file, EMCLicTool.chm, from the PowerPath software CD or the 
\help directory. 

Note: You must have Internet Explorer 5.1 or later to view the online help files. If you do 
not have this browser installed, you may still view the help file from the EMCLicTool.chm 
file.
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emcpreg command

The emcpreg command facilitates scripting options and is the only way to manage 
licenses with the Windows Server 2008 and later core versions. The emcpreg command is 
supported with all supported Windows platform versions.

To add a license with emcpreg command line, enter:

emcpreg -add <key>

where <key> is the product license key.

The PowerPath CLI and System Messages Reference on EMC Online Support provides 
additional information.

PowerPath Administrator
For Windows Server, the PowerPath Administrator runs as a snap-in program within 
Microsoft Management Console (MMC). You can use MMC and the PowerPath Snap-in to 
monitor a local or remote host. "Local or remote administration" on page 58 provides 
additional information.

The PowerPath Administrator is a graphical user interface for configuring, monitoring, and 
managing PowerPath devices. The PowerPath Administrator continuously monitors a 
multipath storage-system environment and automatically updates the configuration 
information that appears. 

You can use PowerPath Administrator to set up and change your device configuration and 
manage physical and logical path components. The PowerPath Administrator displays a 
hierarchical representation of paths, logical devices, and HBAs.

PowerPath Administrator displays the components of a PowerPath system as objects. 
PowerPath Administrator icons represent the PowerPath objects in your configuration. The 
type of icon reflects the state or status of the particular object selected. Table 6 on 
page 56 and Table 7 on page 57 display PowerPath Administrator icons.

PowerPath Administrator panes

As part of MMC, the PowerPath Administrator has two panes:

◆ The scope pane displays PowerPath objects in a hierarchical list that can be expanded 
or collapsed. 

◆ The result pane provides a view of configuration statistics for PowerPath objects 
selected in the scope pane.

PowerPath Administrator device properties dialog box

You can access most of the PowerPath Administrator functions through the tabs available 
in the device Properties dialog box. Right-click the EMC PowerPathAdmin root node and 
then select Properties. 

The PowerPath properties are as follows:

◆ PowerPath admin (root node) properties — Use this to:

• Show root node details. 
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• Set local or remote host options. 

• Set error notification options. 

• Set Auto-Restore. 

• View array management information. 

• Set the path latency options.

• Manage the autostandby feature options.

• Manage persist_path_info option.

Note: The root node is the top-level view of your configuration and represents the host 
that is being managed by PowerPath. The Root Node Properties dialog box contains 
the Details, Computer, and Options tabs. (The Computer tab is present only when you 
are connected to a remote host). 

◆ Storage array properties — Use this to show storage array details. To display this tab, 
select a storage array, right-click, and select Properties.

◆ Storage array port properties — Use this to show storage array port details. To display 
this tab, select a storage array port, right-click, and select Properties.

◆ Adapter properties — Use this to show adapter details and change modes on the 
adapter. To display this tab, select an adapter, right-click, and select Properties.

◆ Disk properties — Use this to show disk details, change modes on the disk, and 
change load-balancing policies and priorities. To display this tab, select a disk, 
right-click, and select Properties.

◆ Path properties — Use this to show path details and change the mode of a path. To 
display this tab, select a path, right-click, and select Properties.

Note: The previous examples illustrate the most common PowerPath Administrator 
functions. The PowerPath Administrator online help for Windows Server provides 
complete information on using all the PowerPath Administrator functions. 
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Icons: standard, unlicensed, and unknown conditions

Table 6 shows icons for standard, unlicensed, unknown, and mismatched states. 
Standard icons represent a configuration in which PowerPath is optimal.

Note: The online help provides more information on icons and their meaning.

Icons: known failure conditions

When a path fails, the failure propagates through other PowerPath Administrator objects. 
These objects are displayed in a hierarchy in the scope pane and result pane. These 
known failure icons represent configurations that are less than optimal.

Table 7 on page 57 shows known failure icons. Icons for:

◆ Degraded conditions.

◆ Failed conditions.

◆ Unlicensed and degraded conditions.

◆ Unlicensed and failed conditions.

Degraded PowerPath objects are represented by a red slash through the standard object 
icon. (Because a path is either open or closed, the path icon is never shown as degraded.) 
Failed PowerPath objects are represented by a red X through the standard object icon.

Table 6  Icons on the PowerPath Administrator

Object Standard Icon Unlicensed Icon Unknown Icon
Mismatched 
Icon

Root Node — Graphical representation of the host and 
top level view of your configuration. N/A

Storage Array — An attached storage system that 
provides logical devices which are managed by 
PowerPath.

N/A

Storage Array Port — Identifies a port within a specific 
storage array that provides I/O paths to the logical 
devices.

N/A

Disk — A logical device managed by PowerPath. Logical 
devices are disk devices presented by the storage 
system.

N/A

Adapter — A device that provides an interface between 
the SCSI or Fibre Channel bus and the computer I/O 
bus. An adapter can have multiple paths associated 
with it.

N/A

Path — The logical or physical I/O path from the host to 
the storage system, including the HBA, cable, and 
interface port.
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The definition of degraded and failed status depends on the context shown in Table 7 on 
page 57. For example, an unlicensed version of PowerPath with degraded or failed paths 
displays icons that combine elements of both the unlicensed and degraded icons.

Unless specified otherwise, all icons display in both the summary and details panes.

Table 7  Icons of known PowerPath failure conditions

Object Degraded Icon Failed Icon
Unlicensed and Degraded 
Icon

Unlicensed and Failed 
Icon

Root Node EMC PowerPath 
Administrator is 
identifying a 

degradation within the 
managed environment.

EMC PowerPath 
Administrator is in 
a failed state.

EMC PowerPath is 
unlicensed and 
identifying a 

degradation within the 
managed environment.

EMC PowerPath 
Administrator is 
unlicensed and in 

a failed state.

Storage 
Array

One or more (but 
not all) paths to 
the storage array 
have failed or are 
in a degraded 

state.

All paths to the 
specific array have 
failed. This array is 
not available.

EMC PowerPath 
Administrator is 
unlicensed. One 
or more (but not 

all) paths to the array 
have failed or are in a 
degraded state.

EMC PowerPath 
Administrator is 
unlicensed. All 
paths to the 

specific array have failed. 
This array is not available.

Storage 
Array Port

One or more (but 
not all) paths to 
the storage array 
port have failed or 

are in a degraded state.

All paths to the 
specific array port 
have failed. This 

array port is not available.

EMC PowerPath 
Administrator is 
unlicensed. One 
or more (but not 

all) paths to the array port 
have failed or are in a 
degraded state.

EMC PowerPath 
Administrator is 
unlicensed. All 

paths to the specific array 
port have failed. This array 
port is not available.

PowerPath 
device 

One or more (but 
not all) paths to 
the disk device 

have failed.

All paths to the 
specific disk 
device have 

failed. This disk is not 
available.

EMC PowerPath 
Administrator is 
unlicensed. One 

or more (but not all) paths 
to the disk device have 
failed.

EMC PowerPath 
Administrator is 
unlicensed. All 

paths to the specific disk 
device have failed. This 
disk is not available.

Adapter One or more (but 
not all) adapters 
have either failed 

or degraded. Displays in 
the Adapters folder in the 
scope pane. 

One or more (but not all) 
paths have failed on the 
specific adapter.

All paths on this 
adapter have 
failed.

EMC PowerPath 
Administrator is 
unlicensed. One 

or more (but not all) paths 
have failed on the specific 
adapter.

EMC PowerPath 
Administrator is 
unlicensed. All 

paths on this adapter 
have failed.

Path Not applicable. One or more of 
the hardware 
components 
that make up the 

path has failed; therefore, 
the entire path failed.

Not applicable. EMC PowerPath 
Administrator is 
unlicensed, and 

one or more of the 
hardware components 
that comprise the path 
has failed; therefore, the 
entire path fails.
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Undefined SP conditions

The following icons represent a rare condition on active/passive arrays, including VNX OE 
and CLARiiON, that produce a double link control card (LCC) failure. If you see these icons, 
the LCC fault light on the VNX OE or CLARiiON array should be amber. Refer to the VNX OE 
or CLARiiON documentation for troubleshooting information, or contact EMC Customer 
Support for information on replacing an LCC.

Table 8 on page 58 shows icons and descriptions specific to CLARiiON arrays.

Local or remote administration
With MMC and the PowerPath Snap-in, you can monitor a local host or a remote host.

◆ Local administration — EMC PowerPath Administrator is installed on the local host by 
default. The installation process provides a preconfigured .msc file to launch the 
Microsoft Management Console (MMC). Once PowerPath is installed, you can use 
PowerPath to monitor the local host immediately. 

To launch MMC with the PowerPath Snap-in:

Select Start > All Programs > EMC > PowerPath > PowerPathAdmin.

Note: The path starts the PowerPath Snap-in and the MMC console on the local host 
with no other action required. However, there may be scenarios in which you need to 
add the PowerPath Snap-in to a new MMC console. For example, you may want to 
create another instance of PowerPath Administrator on the local host or you may have 
deleted the PowerPath Snap-in and want to add it again. "Setting a local host option" 
on page 59 provides additional information on how to add the PowerPath Snap-in to 
the MMC console to monitor a local host.

◆ Remote administration — "Setting a remote host option" on page 59 provides 
additional information on how to add the PowerPath Snap-in to monitor a remote host 
with PowerPath installed.

Table 8  Icons of undefined SP PowerPath failure conditions

Standard Icon Degraded Icon Failed Icon Unlicensed Icon
Unlicensed and 
Degraded Icon

Unlicensed and 
Failed Icon

The 
CLARiiON 
link control 

cards (LCC) have 
failed. The SP 
owning the disk is 
unknown and the 
disk is 
unavailable.

The 
CLARiiON 
link control 

cards (LCC) have 
failed. The SP 
owning the disk is 
unknown and one 
or more (but not 
all) paths to the 
disk device has 
failed. The disk is 
unavailable.

The 
CLARiiON 
link control 

cards (LCC) have 
failed. The SP 
owning the disk is 
unknown and all 
paths to the disk 
device has failed. 
The disk is 
unavailable.

The 
PowerPath 
Administra

tor is unlicensed 
and the CLARiiON 
link control cards 
(LCC) have failed. 
The SP owning the 
disk is unknown 
and the disk is 
unavailable.

The 
PowerPath 
Administra

tor is unlicensed 
and the CLARiiON 
link control cards 
(LCC) have failed. 
The SP owning the 
disk is unknown 
and one or more 
(but not all) paths 
to the disk device 
has failed. The 
disk is 
unavailable.

The 
PowerPath 
Administra

tor is unlicensed 
and the CLARiiON 
link control cards 
(LCC) have failed. 
The SP owning the 
disk is unknown 
and all paths to 
the disk device 
has failed. The 
disk is 
unavailable.
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Setting a local host option

Adding the PowerPath Snap-in to MMC and monitoring a local host is a two-part 
procedure.

Part 1: Opening the MMC
1. Click Start

◆ in the Start Search text box, type mmc.

◆ in the Start Search text box, type cmd and then type mmc.

2. In the Open field, run mmc (32-bit OS versions) or mmc/32 (64-bit OS versions).

Note: 32-bit is only available after product qualification has been requested from EMC 
Online Support.

3. Click OK.

An MMC Console appears. The MMC title bar displays Console1. Within this pane is 
the Console Root. Initially this folder is empty. However, once the snap-in is added, 
this folder will contain the EMC PowerPath Administrator (and any other added 
snap-ins) and is displayed as expandable icons under the Console Root folder.

Part 2: Adding the EMC PowerPath Administrator snap-in
1. From the MMC console, select File > Add/Remove Snap-in.

2. Select  PowerPath Administration and click Add.

3. Select Local Computer.

4. Click Finish.

5. In the Add/Remove Snap-in dialog, click OK. 

EMC PowerPath Administrator is now added to the MMC console.

You can now use EMC PowerPath Administrator to configure, manage, and monitor 
PowerPath devices.

Once you have changed your configuration, save the configuration. "Saving a 
configuration" on page 60 provides additional information.

Setting a remote host option

Adding the PowerPath snap-in to MMC and monitoring a remote host is a two-part 
procedure.

Part 1: Opening the MMC
To open the MMC:

1. Click Start

◆ in the Start Search text box, type mmc.

◆ in the Start Search text box, type cmd and then type mmc.

2. In the Open field,  run mmc (32-bit OS versions) or mmc/32 (64-bit OS versions).
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Note: 32-bit is only available after product qualification has been requested from EMC 
Online Support.

3. Click OK.

An MMC Console appears. The MMC title bar displays Console1. Within this pane is 
the Console Root. Initially this folder is empty. However, once the snap-in is added, 
this folder will contain the EMC PowerPath Administrator (and other snap-ins you may 
add) and is displayed as expandable icons under the Console Root folder. 

Part 2: Adding the EMC PowerPath Administrator snap-in
1. From the MMC console, select File > Add/Remove Snap-in. 

2. Select  PowerPath Administration and click Add.

3. Select Another Computer.

4. Type the computer name or browse for the remote computer.

5. In the Browse for Computer dialog box, click OK.

6. Type your User Name, Domain Name, and Password.

7. Click Finish.

Note: The User Name, Domain Name, and Password fields are subsequently available 
for editing from the root node Properties page if you are using MMC to monitor a 
remote host. The section "Set Remote Host Options" in the PowerPath Administrator 
online help provides additional information.

8. In the Add Standalone Snap-in window, click Add to add another snap-in or click 
Close.

9. In the Add/Remove Snap-in window, click OK. EMC PowerPath Administrator is now 
added to the MMC console.

Saving and loading Administrator settings
You can use EMC PowerPath Administrator to configure, manage, and monitor PowerPath 
devices. The first time you run EMC PowerPath Administrator, there is a default 
configuration. If you make changes, you can save them to a configuration file. The file 
records the serial numbers, mode, policy, and priority for each configured path. You can 
also load the last known configuration or a previously saved file.

Note: PowerPath configuration files are distinct from the Microsoft Management Console 
(MMC) configuration files. If you close the MMC window, MMC prompts you to save the 
MMC settings. These settings are not the same as the EMC PowerPath Administrator 
settings. Saving the MMC console settings does not save your PowerPath configuration 
changes. These changes will be lost unless you complete the following procedure.

Saving a configuration

To save the current PowerPath Administrator settings:
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Note: Saving the configuration may override an existing configuration file. Provide a 
unique file name and use the Save As option to avoid overriding an existing configuration 
file.

◆ Enter powermt save [file=<pathname>]

or

◆ In PowerPath Administrator, right-click the root node and select All Tasks > Save Config 
as. Specify a file name and click Save.

Loading a configuration

You can load the last known reboot state or a previously saved EMC configuration file. 

To load a configuration: 

1. In the scope pane, select the EMC PowerPath Admin root node.

2. To load a previously saved PowerPath configuration, right-click the root node and 
select All Tasks > Load Config File.

To load the last known reboot state, right-click the root node and select All Tasks > 
Load Reboot Config.

Saving MMC console settings
The MMC console enables you to display the PowerPath Snap-in data in many ways. If you 
change your MMC console configuration (for example, if you resize columns, change 
column displays, or change column sort order), you may want to save these new MMC 
console settings. 

If you close the MMC console itself, or the PowerPath Snap-in within the MMC console, 
MMC prompts you with the following message: 

Save console settings to <filename>.msc? 

Click Yes to save the latest console settings. By default, the MMC console settings are 
saved as console1.msc in the folder:

%SystemDrive%\Programs\Administrative Tools 

You can save the console settings anytime with the Console, Save menu option in the 
MMC console. 

To save the file with a different name or to a different location, go to MMC Console > Save 
As.

PowerPath and Systems Management Server (SMS)
PowerPath has been qualified with the Systems Management Server (SMS) software from 
Microsoft, which allows remote management of large groups of Windows-based systems. 
SMS allows you to remotely manage patches, distribute software, deploy operating 
systems, and perform software and hardware inventories. 

The high level steps for deploying PowerPath using SMS are:
Saving MMC console settings 61



Managing PowerPath
1. Create a PowerPath package in SMS.

2. Create a program for that PowerPath package.

3. Assign distribution points to that package.

4. Advertise the package to target clients by defining a collection.

See the Microsoft SMS product documentation for detailed instructions.

Traybar and UAC modifications
Beginning with  Windows Server 2008, Microsoft introduced modifications to the traybar 
monitor program and the User Account Control (UAC):

◆ The traybar monitor program now communicates to the PowerPath service where it 
previously communicated directly with the kernel driver. This means that if the 
PowerPath service is disabled or fails to start, the traybar monitor will not function and 
an error displays. 

◆ For those tasks that require administrator privileges, you receive the elevated prompt 
when:

• Opening the GUI from the traybar monitor.

• Launching admin GUI from a program group.

• Starting the license tool.

When the license tool is launched from the Installation program, you do not receive an 
elevation prompt.

Note: The above information is valid only for built in administrator accounts and any 
accounts which are part of the administrator group, if UAC is turned on.

Audit and error log messages
The EMC PowerPath Family CLI and System Messages Reference on EMC Online Support 
describes audit logging, including instructions for setting up logging in your environment. 
It also lists error messages, descriptions, and suggested corrective action.
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Installing PowerPath and MSCS
If you are installing PowerPath and MSCS for the first time, install PowerPath first, and 
then install MSCS. Installing PowerPath first avoids disruption of cluster services at a later 
time. The Microsoft MSCS documentation provides complete information on planning, 
configuring, managing, and troubleshooting MSCS.

After installing PowerPath and before installing MSCS, run the emcphostid check 
command to check for host conflicts. If the host IDs are not unique, run the emcphostid 
set command to set a unique host ID.

Integrating PowerPath into an existing MSCS cluster
You can integrate PowerPath into an existing MSCS cluster, without shutting down the 
cluster, if there is close coordination between the nodes and the storage system.

Each node in a cluster can own a distinct set of resources. Node A is the primary node for 
its resources and the failover node for node B resources. Conversely, node B is the primary 
node for its resources and the failover node for node A resources.

The Microsoft MSCS documentation provides complete information on planning, 
configuring, managing, and troubleshooting MSCS.

Note: After installing PowerPath on the cluster, any testing involving node failover by 
disconnecting all cables for a LUN or otherwise disrupting the path between the active 
host and the array logs an event message in Windows. These event messages will indicate 
hardware or network failure and possible data loss. If working correctly, the cluster will 
failover to a node with an active path and you can ignore the messages from the original 
node as logged in the event log. 
You should check the application generating I/O to see if there are any failures. If there are 
none, everything is working normally.

The following procedure describes how to install PowerPath on a two-node cluster. You 
can also install PowerPath on clusters with more than two nodes. In these cases, the 
appropriate action is noted where applicable for clusters with more than two nodes.

To add PowerPath to an existing MSCS cluster (with MSCS running on both nodes), follow 
these procedures:

◆ "Moving all resources to node A" on page 65

◆ "Installing PowerPath on node B" on page 65

◆ "Configuring additional paths between the storage system and node B" on page 65

◆ "Moving all resources to node B" on page 65

◆ "Installing PowerPath on node A" on page 65

◆ "Configuring additional paths between the storage system and node A" on page 66

◆ "Returning node A resources to node A" on page 66

◆ "Checking for host ID uniqueness (optional)" on page 66
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Moving all resources to node A

1. Start the Windows Server Failover Cluster Manager Console.

2. Select all groups owned by node B.

3. Move the resources to node A.

4. Pause node B. This keeps the node from participating in the cluster during PowerPath 
installation.

Installing PowerPath on node B

1. Install PowerPath on node B.

In a cluster with more than two nodes, install PowerPath on these other nodes. For 
example, in a four-node cluster, replace node B with nodes B, C, and D as shown in step 4 
in the section "Moving all resources to node A" on page 65.

Configuring additional paths between the storage system and node B

1. If necessary, reconfigure the storage system so its logical devices appear on multiple 
ports.

2. If necessary, install additional HBAs on node B.

3. Connect cables for new paths between node B and the storage system.

4. Run the emcphostid get command and make a note of the returned PowerPath host ID 
for this node.

5. To resume node B, click on node B and right-click > Resume.

In a cluster with more than two nodes, configure additional paths between the storage 
system and these other nodes. In case this is node C, D, and later (that is, this is not the 
first installation node) and Host Id returned by emcphostid get command is not unique 
(matches to Id of one of the previous nodes in this cluster) it needs to be changed 
manually to any arbitrary value unique for this cluster using emcphostid set command.

The check and the possible correction need to be performed before resuming the node.

Moving all resources to node B

1. In the left pane of the Cluster Administrator window, select all groups.

2. Move the resources to node B.

In a cluster with more than two nodes, move all resources to any of the remaining 
nodes. For example, in a four-node cluster, replace node B with any combination of 
nodes B, C, and D to which you want to move resources. 

3. Pause node A.

Installing PowerPath on node A

1. Install PowerPath on node A.
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Configuring additional paths between the storage system and node A

1. If necessary, configure the storage system so its logical devices appear on multiple 
ports.

2. If necessary, install additional HBAs on node A.

3. Connect cables for new paths between node A and the storage system.

4. Run the emcphostid get command to ensure the host IDs are unique on the cluster.

5. Before resuming the node A we need to execute emcphostid get, in case returned ID is 
not unique (matches to Id of one of the previous nodes in this cluster) it needs to be 
changed manually to any arbitrary value unique for this cluster using emcphostid set 
command.

The check and the possible correction need to be performed before resuming the 
node.

Returning node A resources to node A

1. Using the Windows Server Failover Cluster Manager, select all groups previously 
owned by node A.

2. Move the resources back to node A.

Checking for host ID uniqueness (optional)

If emcphostid get calls, checks and possible corrections were performed before every 
node was resumed, we can remove host IDs that are not unique.
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Installing PowerPath and VCS
If you are installing PowerPath and VCS for the first time, install PowerPath first, and then 
install VCS. Installing PowerPath first avoids disruption to the cluster services at a later 
time. The Veritas Storage Foundation High Availability (SFHA) documentation provides 
complete information on planning, configuring, managing, and troubleshooting VCS.

After installing PowerPath and before installing VCS, run the emcphostid check command 
to check for host conflicts. If the host IDs are not unique, run the emcphostid set 
command to set a unique host ID.

Installing PowerPath in an existing VCS environment

Ensure that you follow these steps to manage your cluster environment. Failure to do so 
can result in data corruption and data loss. Refer to the VCS documentation on how to 
configure and manage VCS in a clustered environment.

To install PowerPath in an existing VCS:

1. In the Cluster Administrator window, ensure all resources are on the primary node in 
the cluster. When the cluster resources are on the primary node, the ClusterService in 
the Status View dialog box appears as online.

2. From the navigation pane on the left, right-click ClusterService and select Disable. This 
disables the secondary node in the VCS configuration.

3. Install PowerPath on the secondary node. Follow the procedures in “Installation 
procedures” on page 18.

4. Run the emcphostid get command and make a note of the returned PowerPath host ID 
for this node.

Note: If this is not the first installation node and the returned host ID is not unique, 
change the host ID to any arbitrary value that is unique on the cluster using the 
emcphostid set command. You must perform the check and any host ID corrections 
before resuming the node.

5. After installation and reboot of the secondary node, right-click ClusterService and 
select Enable to re-enable the node in the VCS configuration.

6. Right-click ClusterService, select Switch to, and then select the secondary node to 
move all cluster resources over to the secondary node.

7. Run vxdisk list. You will see the devices are in the BasicGroup and RAW group.

The vxdisk list command will display the proper DiskType and DiskGroup information.

8. Once the resources are available on the secondary node:

a. Run vxassist rescan.

b. Run vxdisk list to verify the disks are now in the proper disk group and show MBR.
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If there are additional nodes in the cluster configuration, repeat steps 2 through 8 for 
each node.

DiskType and DiskGroup information
The vxdisk list command displays DiskType as RAW instead of MBR and all disks appear to 
be in the default DiskGroup ‘BasicGroup’ after the installation of PowerPath.

C:\Documents and Settings\Administrator>vxdisk list
Name     MediaName Diskgroup  DiskStyle Size(MB) FreeSpace(MB) Status EnclosureID     P#C#T#L#
Harddisk0          BasicGroup MBR     156327    127327     Uninitialized DISKS@lhclu056 P0C0T0L0
Harddisk1   Disk1   dg1       RAW     10236     0          Imported      DGC0           P2C0T0L0
Harddisk2   Disk2   dg1       RAW     10236     0          Imported      DGC0           P2C0T1L1
Harddisk3   Disk3   dg1       RAW     10236     5118       Imported      DGC0           P2C0T0L2
Harddisk4   Disk4   dg1       RAW     10236     5118       Imported      DGC0           P2C0T1L3
 
C:\Documents and Settings\Administrator>vxassist rescan
Successfully rescanned

Note: Notice disk now properly show diskstyle as MBR

C:\Documents and Settings\Administrator>vxdisk list
Name      MediaName  Diskgroup  DiskStyle Size(MB) FreeSpace(MB) Status EnclosureID   P#C#T#L#
Harddisk0            BasicGroup  MBR      156327   127327 Uninitialized DISKS@lhclu056 P0C0T0L0
Harddisk1   Disk1     dg1        MBR      10236    0          Imported      DGC0           P2C0T0L0
Harddisk2   Disk2    dg1         MBR      10236    0          Imported      DGC0           P2C0T1L1
Harddisk3   Disk3    dg1         MBR      10236    5118       Imported      DGC0           P2C0T0L2
Harddisk4   Disk4    dg1         MBR      10236    5118       Imported      DGC0           P2C0T1L3

1. Disable the primary node in the VCS configuration and install PowerPath as described 
in “Installation procedures” on page 18.

2. After installing PowerPath, reboot the primary node.

3. If the host IDs are not unique, run the emcphostid set command to set unique host 
IDs.

4. Re-enable the node in the VCS configuration.

5. Move all cluster resources over to the primary node. Once the resources are available, 
run vxassist rescan.
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WHQL-certified driver
On Windows Server, the EMC PowerPath driver is WHQL-certified. To view the PowerPath 
driver signature:

1. Select Start > Control Panel > System.

2. Click Device Manager.

3. Expand the Storage controllers node. 

4. Right-click EMS device bus and then select Properties.

5. Click Driver > Driver Details to see the driver signature information.

When the driver is signed, the field contains information about the organization that 
signed the driver.
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Files created by PowerPath installation
The following files are added when PowerPath is installed on 32-bit and 64-bit hosts. 
These file locations can change if you do not install to the default locations during 
PowerPath installation. Hence <Install directory> is denoted as a variable in the following 
sections.

Note: All driver files (.sys, .cat, and .inf) are copied to the internal system directories by the 
operating system when they are installed.

<Install directory>\PowerPath
◆ db_recover.exe
◆ db_recover.exe.intermediate.manifest
◆ difxapi.dll
◆ EMC_PowerPath_Console.msc
◆ EmcAdminProxy.dll
◆ EmcAdminSvr.exe
◆ emcp_mp_rtl.dll
◆ emcphostid.exe
◆ EmcpLogMsgs.dll
◆ EmcpMgmtComp.exe
◆ EmcpPerfmonPmiPrvdr.dll
◆ EmcPowerPathAdmin.dll
◆ EmcPowPN22.dll
◆ emcpreg.exe
◆ libdb51.dll
◆ libdb51.dll.intermediate.manifest
◆ logcon.exe
◆ ManagementComp_Config.exe
◆ powerkmd.exe
◆ powerpath.man
◆ powermig.exe
◆ powermigcl.exe
◆ powermt.exe
◆ PowMigSrvc.exe
◆ ppinstall.exe
◆ pthreadVC2.dll
◆ EmcLicTool.exe
◆ EmcLicTool_CHS.dll
◆ EmcLicTool_DEU.dll
◆ EmcLicTool_ESP.dll
◆ EmcLicTool_FRA.dll
◆ EmcLicTool_ITA.dll
◆ EmcLicTool_JPN.dll
◆ EmcLicTool_KOR.dll
◆ EmcLicTool_PTB.dll
◆ emcp_lic_rtl.dll
◆ emcp_mp_rtl.dll
◆ emcp_mpapi_rtl.dll
◆ EmcPowMon.exe
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◆ EmcPowRes.dll
◆ EmcPowSrv.exe
◆ EmcpSvcErr.dll
◆ libeay32.dll
◆ server.pem

ssleay32.dll<Install directory>\EMC\PowerPath\Drivers 
◆ EmcpBase.cat
◆ Emcpbase.inf
◆ EmcpBase.sys
◆ EmcpClass.cat
◆ EmcpClass.inf
◆ EmcpClass.sys
◆ EmcpCoinst30.dll
◆ emcpdm.cat
◆ emcpdm.inf
◆ EmcpDm.sys
◆ emcpgpx.cat
◆ emcpgpx.inf
◆ EmcpGpx.sys
◆ EmcpMpx.cat
◆ EmcpMpx.inf
◆ EmcpMpx.sys
◆ LamClar.cat
◆ LamClar.inf
◆ LamClar.sys
◆ LamEss.cat
◆ LamEss.inf
◆ LamEss.sys
◆ LamGen.cat
◆ LamGen.inf
◆ LamGen.sys
◆ Lamhit.cat
◆ Lamhit.inf
◆ Lamhit.sys
◆ Lamhpxp.cat
◆ Lamhpxp.inf
◆ Lamhpxp.sys
◆ LamInv.cat
◆ Laminv.inf
◆ Laminv.sys
◆ LamSymm.cat
◆ LamSymm.inf
◆ LamSymm.sys
◆ Lamnet.sys
◆ Lamnet.inf
◆ Lamnet.cat
◆ Lamxtremio.sys
◆ Lamxtremio.inf
◆ Lamxtremio.cat
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Windows\Help
◆ EmcLicTool.chm
◆ EmcLicToolCHS.chm
◆ EmcLicToolDEU.chm
◆ EmcLicToolESP.chm
◆ EmcLicToolFRA.chm
◆ EmcLicToolITA.chm
◆ EmcLicToolJPN.chm
◆ EmcLicToolKOR.chm
◆ EmcLicToolPTB.chm
◆ EmcPowerPathAdminMMC.chm

Windows\Cluster
◆ ppme.dll

%ALLUSERSPROFILE%\EMC\PowerPath
◆ bootstrapper_*.log
◆ msi_*.log
◆ ppinstall_*.log
◆ vcredist_<platform>_*.log
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local host administration  58
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